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Bab I
Pengenalan Komputer

Apa Itu Komputer ?
Komputer adalah sekumpulan alat elektronik yang saling bekerja sama 
untuk menerima data, mengolah data, dan menampilkan data untuk 
pengguna. 

Perkembangan komputer dari pertama memasuki pasar hingga 
sekarang dapat dibagi menjadi lima generasi yang berbeda. 

Pengertian komputer yang didefinisikan secara berbeda 
oleh beberapa ahli.
Menurut Blissmer (1985), komputer adalah suatu alat elektronik yang 
mampu melakukan beberapa tugas, yaitu menerima input, memproses 
input sesuai dengan instruksi yang diberikan, menyimpan perintah-
perintah dan hasil pengolahannya, serta menyediakan output dalam 
bentuk informasi.

Sedangkan menurut Sanders (1985), komputer adalah sistem 
elektronik untuk memanipulasi data yang cepat dan tepat serta dirancang 
dan diorganisasikan supaya secara otomatis menerima dan menyimpan 
data input, memprosesnya, dan menghasilkan output berdasarkan 
instruksi-instruksi yang telah tersimpan di dalam memori.



Bahan Ajar Aplikasi Komputer2

Komputer mempunyai beberapa karakteristik:
1.	 Alat elektronik. 
2.	 Dapat menerima input data. 
3.	 Dapat mengolah data. 
4.	 Dapat memberikan informasi. 
5.	 Menggunakan suatu program yang tersimpan di memori komputer 

(‘stored program). 
6.	 Dapat menyimpan program dan hasil pengolahan 
7.	 Bekerja secara otomatis

Sejarah Singkat Komputer 
Dalam perkembangannya, komputer telah mengalami suatu evolusi yang 
sangat berarti bagi peradaban manusia, berikut adalah sejarah singkat 
mengenai komputer:

Komputer Generasi Pertama 1940-1956

Perangkat komputer yang pertama ternyata dikembangkan 
untuk desain pesawat dan peluru kendali. komputer generasi pertama 
menggunakan tabung hampa udara sebagai sirkuit dan drum magnetik 
untuk memori.
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Komputer generasi pertama ini sangat mahal dan besar, hingga 
mengisi seluruh ruangan. Dan mempunyai bobot 30 ton, panjang 30 M, 
dan tinggi 2,4 M. 

Komputer generasi pertama mengandalkan machine language, level 
bahasa pemrograman paling rendah yang dimengerti komputer. 

Komputer Generasi Kedua 1956-1963

Komputer Generasi Kedua muncul setelah ditemukannya transistor, 
yang kemudian mulai mengganti tabung vakum dalam desain komputer. 
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Transistor jauh mengungguli tabung hampa dan memungkinkan 
komputer menjadi lebih kecil, cepat, murah, dan hemat energi 
dibandingkan dengan pendahulunya.

Komputer Generasi Ketiga 1964-1971

Pengembangan integrated circuit menjadi penanda komputer generasi 
ketiga. Dalam pemakaian komputer generasi kedua, transistor membuat 
komputer cepat panas, maka komputer generasi kedua mulai ditinggalkan
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Kemudian pada tahun 1958 Jack Billy menciptakan integrated 
circuit chip atau IC, kepingan kecil yang mampu menampung banyak 
komponen menjadi satu. Komputer pada generasi ini menjadi lebih kecil 
dan cepat serta murah, memungkinkan juga menjadi tersedia untuk 
khalayak umum.

Komputer Generasi Keempat 1971-Sekarang

Komputer yang kita pakai sekarang merupakan komputer generasi 
keempat, yang mana dibuat dengan menggunakan komponen dasar 
bernama Microprosesor. 

Intel menjadi sebuah perusahaan yang paling berpengaruh terhadap 
perkembangan chip microprosesor karena mereka berhasil menciptakan 
intel 4004 yang merupakan cikal bakal perkembangan komputer.

Banyak sekali kemajuan pesat yang terjadi pada generasi ini, seperti 
diciptakannya mouse, hingga komputer jinjing yang disebut dengan 
laptop. Bahkan prosesor atau CPU pun mengalami perkembangan dari 
waktu ke waktu hingga sekarang.
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Komputer Generasi Kelima Sekarang - Masa Depan

Generasi kelima ini sebenarnya masih tahap pembangunan, yang 
mana generasi ini akan mempunyai teknologi yang dibuat berdasarkan 
kecerdasan buatan (artificial intelligence).

Tugas
1.	 Dalam tugas ini, buatlah kelompok yang terdiri atas 3 orang.
2.	 Bayangkan kelompok Anda merupakan pegawai sebuah perusahaan.
3.	 Pada suatu waktu pimpinan perusahaan meminta kelompok Anda 

untuk membuat ide baru untuk perkembangan komputer.
4.	 Silakan menentukan nama perusahaan, produk, dan cara kerja 

komponen yang di buat.
5.	 Buatlah berupa makalah dan presentasikan di pertemuan yang 

berikutnya.
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Bab II
Manfaat Komputer

Apa Manfaat Komputer?
Di era serba digital, keberadaan komputer menjadi salah satu pendukung 
mobilitas manusia yang lebih mudah. Segala sesuatu bisa dilakukan 
secara mudah menggunakan perangkat elektronik yang telah berkembang 
canggih ini. 

Jika dulu komputer memiliki bentuk yang besar dilengkapi tabung 
dan CPU, kini modernisasi membuat komputer bisa lebih praktis dalam 
bentuk laptop atau notebook.

Berikut manfaat komputer dalam kehidupan manusia modern yang 
bisa dimanfaatkan sesuai kebutuhan: 

1.	 Komputer Sebagai Sarana Mempermudah Kerja
Komputer merupakan perangkat kerja yang memudahkan semua hal 
termasuk menghemat waktu, biaya dan tenaga Anda. 

Contohnya jika dahulu penulisan surat dilakukan menggunakan 
mesin tik biasa, kini lebih mudah menggunakan aplikasi Microsoft 
word. Sekarang bisa mengetik, mengedit dan menyimpan hasil kerja 
tanpa harus takut melakukan kesalahan saat dicetak di kertas surat.

2.	 Komputer Bisa Menjadi Alat Hiburan
Memiliki komputer sangat membantu manusia yang ingin merelaksasi 
pikiran dari kejenuhan harian. Bisa menonton film, mendengarkan 
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musik, bermain game dan berbagai jenis aplikasi yang bisa dimainkan 
lewat komputer.

3.	 Komputer Bisa Menjadi Sarana Informasi
Melalui komputer yang terkoneksi internet, Bisa melakukan apa saja 
termasuk belajar ilmu dan wawasan baru. Juga bisa mendapatkan 
banyak referensi materi hinggga kemudahan info membangun 
jaringan yang bermanfaat untuk pribadi atau usaha.

4.	 Bisa Menjadi Sarana Pendidikan
Manfaat paling baik dari alat canggih ini antara lain bisa menjadi 
media pembelajaran di sekolah atau rumah. Tinggal unduh aplikasi 
yang ingin dipelajari di komputer seperti power point, corel draw, 
photoshop dan masih banyak aplikasi yang lain. 

5.	 Komputer Bisa Menjadi Sarana Komunikasi
Menggunakan komputer dilengkapi dengan koneksi internet bisa 
memberikan kemudahan di bidang komunikasi. Bisa melakukan 
chatting, video call atau bisa mengirim dokumen dalam bentuk audio, 
video atau teks.

Peran Komputer dalam Kehidupan Sehari-hari?
1.	 Bidang Pendidikan

Dengan adanya komputer mempermudah bagi pegawai administrasi 
sekolah untuk membuat kurikulum pengajaran, jadwal pelajaran 
sekolah, membuat daftar nama siswa, membuat daftar nilai siswa, 
membuat absen siswa, membuat perhitungan gaji pegawai dan 
membuat perencanaan pengajaran bagi guru-guru sekolah. 

Mengakses Informasi Pendidikan lewat Internet. Seiring 
perkembangan jaman Internet telah merambah sekolah-sekolah 
setingkat kecamatan,sehingga akses informasipun semakin mudah 
diperoleh untuk kemajuan pendidikan tiap-tiap sekolah.
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2.	 Bidang Kesehatan
Mempermudah Dokter dan Perawat dalam memonitor kesehatan 
pasien monitor detak jantung pasien lewat monitor komputer, aliran 
darah, memeriksa organ dalam pasien dengan sinar X. 

Sebagai contoh saat perawatan Almarhum Mantan Presiden 
Soeharto di Rumah Sakit Pertamina Jakarta, tahun 2008. 

Dengan teknologi modern bisa memonitor, bahkan menggantikan 
fungsi organ dalam seperti Jantung, Paru-paru dan Ginjal. Itu 
merupakan teknologi kesehatan yang digabungkan dengan teknologi 
Informasi dan Komputer.

3.	 Bidang Transportasi
Dengan komputer semua jadwal dan jalur penerbangan yang transit 
dibandara bisa di program dan dijadwalkan dengan komputer. 
Untuk menerbangkan sendiri pesawat dilengkapi dengan peralatan 
komputer. 

Bahkan setelah mencapai ketinggian tertentu pesawat bisa di 
terbangkan otomatis dengan pilot otomatis yang sudah diprogram 
di dalam komputer. 

Dengan komputer, narigasi kapal laut bisa ditentukan koordinat 
dan arah gerak kapal. Demikian juga penjualan tiket di Bandara, 
Stasiun, Dan Terminal Bus di layani dengan cepat menggunakan 
komputer.

4.	 Bidang Barang dan Jasa
Kantor Pos bisa mengirimkan dokumen pengiriman barang lebih 
cepat dan akurat. Dengan adanya komputer dan internet orang tidak 
lagi menunggu berhari-hari menerima surat, cukup lewat email saja 
lebih cepat dalam sekejap, jadi dunia menjadi semakin sempit dalam 
arti bisa diakses sedemikian cepatnya.
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5.	 Bidang Industri Otomotif
Mobil-mobil di buat dari kerangka body, mesin, peralatan elektronik 
di pabrik dengan bantuan robot yang dikendalikan oleh komputer 
dengan leih akurat. 

Dengan bantuan komputer pabrik-pabrik otomotif bisa 
memproduksi mobil dalam jumlah ratusan perbulan, yang tidak 
mungkin dikerjakan secara manual dengan tenaga manusia.

6.	 Bidang Jasa Konstruksi
Dengan komputer para Insiyur dan Arsitek mendesain gambar 
konstruksi dengan pemodelan dan perhitungan yang akurat, cepat 
dan tepat. 

Gambar kontruksi didesain menggunakan program CAD, 
sedangkan untuk perhitungan analisis dan penganalisa kekuatan 
menggunakan program SAP2000 atau STAD III yang dioperasikan 
dengan bantuan komputer.

7.	 Bidang Industri Perfilman
Semua efek-efek di dunia akting, animasi, dan penyotingan adegan 
film semua di rekam dengan perangkat elektronik yang dihubungkan 
dengan komputer. 

Animasinya juga di kembangkan mempergunakan animasi yang 
dibuat dengan aplikasi komputer. 

Sebagai contoh film-film Hollywood berjudul TITANIC itu 
sebenarnya tambahan animasi untuk menggambarkan kapal raksasa 
yang pecah dan tenggelam, sehingga tampak menjadi seolah-olah 
mirip dengan kejadian nyata.
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Bab III
Cara Kerja Komputer

Bagaimana cara kerja komputer?
Komputer menjalankan perintah secara berurutan, dengan data yang 
terus-menerus berpindah dari input dan memori ke prosesor perangkat. 

Saat ini, komputer melakukan pekerjaan yang dulunya rumit menjadi 
lebih sederhana. Cara kerja komputer adalah mengambil informasi (input), 
mengolah informasi (pemrosesan), menyimpan informasi (penyimpanan), 
dan memuntahkan hasil (output). 

Dengan penjelasan sebagai berikut:

1.	 Mengambil informasi (Input)
Mengambil informasi (input) merupakan tahap awal dari proses 
pengolahan yang terjadi pada sistem komputer. Mengambil informasi 
(input) Cara kerja komputer dimulai dengan mengambil informasi 
(input). 

Input komputer dilakukan oleh manusia sebagai pengguna (user). 
Informasi dimasukkan oleh pengguna memalui perangkat input. 

Perangkat input kemudian mengubah informasi menjadi data 
digital yang dapat dipahami komputer yaitu bahasa biner 1 dan 0.
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2.	 Penyimpanan informasi (penyimpanan)
Setelah informasi diinput, informasi akan disimpan sebagai memori 
oleh komputer. Ada dua jenis komponen penyimpanan dalam 
komputer yaitu RAM (Random Access Memory) dan juga memori 
persisten. 

Memori yang baru diinput biasanya disimpan dalam RAM, 
karena RAM adalah penyimpan data yang sedak aktif. RAM bekerja 
sangat cepat, ia dapat menyimpan 1 byte data hanya dalam waktu 1 
nano detik saja. 

Semua pekerjaan yang sedang dilakukan komputer secara aktif 
disimpan dalam RAM. Misalnya saat sedang mengetik, teks tersebut 
disimpan dahulu dalam RAM atau saat sedang membuka tab browser, 
semua tab yang sedang dibuka disimpan dalam RAM.

3.	 Mengolah informasi (pemrosesan)
Data input yang disimpan dalam RAM tersebut kemudian bisa diolah 
oleh CPU sebagai otak dari komputer. Segala macam perintah yang 
diinput secara dioleh CPU dengan bantuan dari RAM. 

Hal tersebut karena CPU tidak memiliki memori, artinya CPU 
tidak mengingat atau menyimpan apapun. Sehingga semua data yang 
diproses CPU secara actual diambil dari RAM.

4.	 Menyimpan informasi (penyimpanan)
Setelah data selesai diolah, baru kemudian data dapat disimpan secara 
permanen dalam memori persisten. Pengertian dan Manfaatnya 
Contoh memori persisten adalah hard disk dan juga flash drive. 
Dalam memori persisten data byte akan disimpan dalam bentuk 
file atau folder atau informasi dapat disimpan dalam waktu lama 
dan dapat diakses lagi sewaktu-waktu oleh pengguna. Penyimpanan 
resisten inilah yang memungkinkan kita menyimpan foto, video, fil, 
dan folder dalam format apapun di komputer.
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Mengaktifkan/menghidupkan komputer:
Langkah-langkah untuk menghidupkan komputer adalah:
1.	 Pastikan semua peralatan komputer tersambung dengan benar 

termasuk penggunaan arus listrik
2.	 Lakukan pengecekan pada Floppy Drive, harus dalam keadaan kosong 

(kalau ada)
3.	 Nyalakan komputer dengan menekan tombol Power pada monitor 

dan CPU, kemudian tunggu sampai komputer selesai melakukan 
booting.

4.	 Setelah proses booting selesai, komputer akan menampilkan desktop. 

Cara Kerja Komputer Saat Dinyalakan:
Ketika kita pertama kali menyalakan komputer, tentu saja mesin akan 
melewati beberapa proses internal sebelum komputer siap untuk 
digunakan. Proses internal ini di sebut proses boot.

Boot merupakan singkatan dari bootstrap yang prosesnya ini 
dikendalikan oleh sistem input output dasar yaitu BIOS.

BIOS merupakan perangkat lunak yang tersimpan di chip flash 
memory. BIOS ini tertanam di mainboard, selain mengendalikan proses 
booting perangkat keras ini juga menyediakan user interface konfigurasi 
dasar untuk hardware komputer.

Pada user interface tersebut kita bisa mengkonfigurasikan beberapa 
hal seperti urutan membaca drive ketika booting dan juga seberapa cepat 
prosesor yang harus dibiarkan berjalan.

Cara Kerja Komputer Pada Saat Booting 
1.	 Saat tombol turn on atau turn off ditekan, maka komputer akan 

mengirimkan daya menuju ke mainboard dan juga komponen lain.
2.	 PC akan melakukan POST atau Power On Self Test. Dimana POST 

ini merupakan program komputer kecil yang terdapat pada BIOS 
yang memeriksa kegagalan pada perangkat keras. Biasanya saat 
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komputer dinyalakan ini BIOS akan memberikan suara satu bip 
yang memberikan sinyal semuanya baik-baik saja.

3.	 PC akan menampilkan informasi di monitor dengan menunjukan 
detail tentang proses dari booting. Hal ini termasuk juga produsen 
serta revisi BIOS, jumlah RAM, spesifikasi Processor dan juga drive 
yang terdeteksi.

4.	 BIOS akan mencoba mengakses sektor pertama dari drive yang 
menjadi disk boot. Sektor pertama ini merupakan kilobyte pertama 
yang secara berurutan, apabila drive dibaca secara berurutan dimulai 
dengan alamat penyimpanan yang tersedia pertama.

5.	 BIOS nantinya akan mengkonfirmasi jika terdapat bootstrap loader. 
Pada sektor pertama dari disk boot ini membuat boot loader ke dalam 
memori atau RAM.

6.	 Selanjutnya setelah boot loader berada di memori, BIOS akan 
menyerahkan pekerjaan ke boot loader yang selanjutnya akan memuat 
sistem operasi.

7.	 Saat bootloader menyelesaikan tugasnya, hal tersebut akan 
mengalihkan kendali PC ke dalam sistem operasi.

Cara Kerja Komputer Pada Sistem Operasi: 
Setelah PC menyelesaikan proses Booting, kita bisa mengontrol perangkat 
hardware yang membentuk komputer tersebut.

Kebanyakan komputer di Indonesia ini menggunakan sistem operasi 
Windows. Sistem operasi Windows ini dibuat untuk menghubungkan 
perangkat keras dengan pengguna. Sistem operasi pada komputer ini 
bertanggung jawab terhadap beberapa tugas seperti:
1.	 Memecahkan pekerjaan prosesor untuk menjadi potongan yang bisa 

dikelola serta memprioritaskannya sebelum mengirim ke CPU.
2.	 Mengkoordinasikan aliran data yang masuk dan juga yang keluar dari 

RAM, kemudian menentukan kapan waktunya untuk menggunakan 
memori virtual di harddisk untuk menambahkan jumlah RAM jika 
tidak mencukupi.
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3.	 Menyediakan antarmuka yang berbasis perangkat lunak antar 
komponen dan juga setiap perangkat yang terhubung menuju 
komputer. Misalnya seperti menerjemahkan input keyboard dan 
menyesuaikan data grafik dengan layar monitor.

4.	 Mengarahkan tempat data yang harus disimpan dengan permanen 
di hardisk. Tugas lainnya seperti membaca, membuat, menyalin atau 
memindahkan serta menghapus dokumen.

5.	 Menyediakan pertukaran data dari program perangkat lunak dan juga 
PC. Aplikasi harus disetting agar bisa berguna dengan user interface 
sistem operasi yang digunakan.

6.	 Menjembatani antara pengguna dengan hardware dari komputer, 
artinya sistem operasi ini bertanggung jawab agar setiap hardware 
bisa berjalan dan juga digunakan oleh pengguna.

Mematikan komputer dengan prosedur yang benar:
Langkah-langkah untuk mematikan komputer adalah:
1.	 Klik menu Start
2.	 Pilih Turn Off Computer
3.	 Akan muncuk kotak dialog:

Dengan penjelasan:

a.	 Stand By: Mengistirahatkan komputer tapi komputer dalam
b.	 keadaan hidup
c.	 Turn Off: Mematikan komputer
d.	 Restart: Membooting ulang
e.	 Cancel: Membatalkan perintah untuk mematikan komputer

4.	 Untuk mengakhiri penggunaan komputer klik Turn Off.
5.	 Matikan monitor dengan menekan tombol Power. 



Bahan Ajar Aplikasi Komputer16

Perangkat keras

Penjelasan:
1.	 Power Supply (Sumber Daya Listrik)
2.	 CD-ROM/DVDROM Drive (Mampu membaca DVD/CD)
3.	 Hard Drive (Penyimpanan Data Sekunder dan berisi Piringan 

Magnetis)
4.	 Floppy Drive (Media penyimpanan yang terdiri dari media 

penyimpanan magnetis tipis dan fleksibel).
5.	 Disk Controllers (Meneruskan data dan intruksi ke Disk Drive).
6.	 Expansion Slot (Intergrasi dari Circuit Boards ke Mother Board).
7.	 Video Card (Menerjemahkan informasi gambar ke dalam berbagai 

arus listrik yang diperlukan untuk menampilkan gambar pada 
monitor).

8.	 Sound Card (Merekam dan Mereproduksi suara multimedia).
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9.	 RAM (kumpulan microchip yang diluruskan pada papan sirkuit kecil 
yang masuk ke dalam slot dengan beberapa ratus atau lebih konektor)

10.	 Real-Time Clock (komponen ini adalah drummer yang mengatur 
langkah dan menyinkronkan pekerjaan semua komponen lainnya).

11.	 CMOS (Chip memori khusus yang menggunakan baterai kecil untuk 
menyimpan informasi tentang konfigurasi perangkat keras PC Anda 
bahkan ketika komputer dimatikan).

12.	 BIOS (Chip yang menentukan kepribadian, atau individualitas, dari 
Komputer).

13.	 CMOS Battery (Baterai yang digunakan oleh BIOS untuk tetap aktif 
meski tanpa aliran listrik).

14.	 Microprocessor (Kumpulan transistor yang rapat dan rumit yang 
diatur sehingga mereka dapat digunakan untuk memanipulasi data).

15.	 Heat Sink (Pendingin).
16.	 Fan (mengeluarkan panas dan menggantinya dengan udara segar ke 

dalam sistem).
17.	 Usb Ports (Perangkat Penghubung).
18.	 Mouse Ports (konektor Input/Output).
19.	 Keyboard Port(konektor Input/Output).
20.	 Network Connector(konektor PC pada sebuah jaringan).
21.	 Parallel Port (konektor PC pada printer atau driver lainnya).
22.	 Serial Ports (konektor Input/Output).
23.	 Sound Card Connection (Soket Eksternal untuk memasang mikrofon, 

speaker atau sumber daya eksternal).
24.	 Modem (Penghubung PC ke saluran telepon sehingga dapat 

mengakses layanan informasi dan internet).
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Bab IV
Sistem Operasi / Operating 
System (OS)

Sistem Operasi adalah?
Sistem Operasi (OS) merupakan perangkat lunak bertindak sebagai 
antarmuka antara pengguna komputer dan perangkat keras komputer serta 
mengontrol pelaksanaan semua jenis program, termasuk menjalankan 
perangkat lunak aplikasi seperti program-program pengolah kata, 
penjelajah web, dll..

Tujuan SO
Tujuan dari sistem operasi adalah mengontrol eksekusi program-program 
aplikasi dan juga sebagai interface antara pengguna komputer dan 
hardware komputer. 

Namun, secara umum sistem operasi memiliki tiga tujuan dasar:
1.	 Efisiensi: sistem operasi memungkinan sumber daya sistem komputer 

untuk digunakan dengan cara yang efisien.
2.	 Kemudahan: sistem operasi membuat komputer lebih mudah dipakai.
3.	 Kemampuan berevolusi: sistem operasi harus disusun sedemikian 

rupa sehingga memungkinkan pengembangan yang efektif, pengujian, 
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dan beberapa fungsi sistem yang baru tanpa mengganggu layanan 
yang telah ada.

Fungsi Dasar Sistem Operasi
1.	 Menjembatani hubungan antara hardware dan program aplikasi yang 

dijalankan user.
2.	 Mengatur dan mengawasi penggunaan perangkat keras oleh user dan 

berbagai program aplikasi (Resource Allocator).
3.	 Sebagai program pengendali yang bertujuan untuk menghindari 

kekeliruan (error) dan pengguna komputer yang tidak perlu sebagai 
guardian yang menjaga komputer dari berbagai kemungkinan 
kerusakan.

4.	 Manajer sumber daya hardware, seperti mengatur memori, printer, 
CD ROM, dll.

Komponen utama SO
1.	 Kernel: Merupakan suatu software yang membentuk sistem dan 

memiliki tugas melayani bermacam-macam program aplikasi untuk 
mengakses hardware komputer secara aman dan terkendali.

2.	 File: file di sini merupakan file-file yang dibentuk atau dijalankan oleh 
sistem operasi. File juga di sini berarti sitem berkas dan file sistem 
yang dimiliki oleh suatu sistem operasi.

3.	  User interface: sebuah sistem operasi memliki karakteristik interface 
yang memiliki interaksi antara user dengan komputer. Bentuk umum 
user interface yang ada adalah: 
a.	 Command line interface atau command line interpreter (CLI)
b.	 Graphical user interface

Jenis Sistem Operasi
Sistem operasi dapat dibedakan berdasarkan jumlah pengguna program 
yang dapat dijalankan, juga berdasarkan jenis software atau jenis hardware 
yang digunakan. 
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Komputer
1.	 DOS
2.	 Windows
3.	 Linux
4.	 Mac OS

Smartphone / Handphone
1.	 Java
2.	 Symbian
3.	 Blackberry
4.	 Android
5.	 IOs

Berdasarkan jumlah penggunaan dan program yang dijalankan, 
sistem operasi dapat dikategorikan dengan:
1.	 Single User – Single Tasking: satu komputer hanya bisa digunakan 

oleh satu user dan hanya bisa menjalankan satu program di satu 
waktu, contohnya DOS (Disk Operating System).

2.	 5 Multi User – Single Tasking: satu kompuetr dapat digunakan oleh 
banyak user namun tiap user hanya bisa menjalankan satu program 
(aplikasi) di satu waktu, contohnya Novell Netware yang menjalankan 
SO Network berbasis DR-DOS.

3.	 Single User – Multi Tasking: satu komputer dipakai oleh satu user 
dan dapat menjalankan banyak program di satu waktu, contohnya: 
Windows, MacOS, BeOS, JDS, dll.

4.	 Multi User – Multi tasking: satu komputer dipakai bersamaan oleh 
banyak user yang dapat menjalankan banyak program di satu waktu, 
contohnya: Unix, Linux, FreeBSD, (SO turunan Unix) atau Windows 
dengan aplikasi Citrix Metaframe, dll.

Dos
1.	 Sistem Operasi DOS adalah DOS (Disk Operating System ) merupakan 

salah satu software yang termasuk dalam golongan system operasi. 
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Disk Operating System dipakai pada media penyimpan disk, baik 
disket maupun harddisk

2.	 Beberapa produk DOS sampai saat ini adalah:
DOS 1.0
DOS 2.0
DOS 3.0: DOS 3.1, DOS 3.2 dan DOS 3.3
DOS 4.0
DOS 5.0
DOS 6.0

Windows
Windows adalah salah satu software sistem operasi yang dikeluarkan 
oleh perusahaan Microsoft Inc. Microsoft Windows adalah software 
sistem informasi yang paling populer untuk para pengguna PC. Tampilan 
Windows yang “user friendly” membuatnya menjadi pilihan utama.
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Macam-macam windows:
1.	 Ms-Dos (1980-1984)
2.	 Windows 1.0 – Windows 1.04 (1985-1987)
3.	 Windows 2.0 (1987)
4.	 Windows 3.0 (1990)
5.	 Windows NT 3.1 (1992)
6.	 Windows for Workgroups 3.11 (1993)
7.	 Windows NT Workstation 3.5 (1994)
8.	 Windows 95 (1995)
9.	 Windows NT Workstation 4.0 (1996)
10.	 Windows 98 (1998)
11.	 Windows 98 Second Edition (1999)
12.	 Windows Millennium Edition (Windows Me) (2000)
13.	 Windows 2000 Profesional (2000)
14.	 Windows 2000 Server
15.	 Windows XP (2001)
16.	 Windows Vista (2006)
17.	 Windows 7
18.	 Windows 8
19.	 Windows 10
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Mac OS
Mac OS adalah sistem operasi yang dibuat oleh Apple. Sistem operasi ini 
sudah terpasang pada semua komputer Macintosh (disebut Mac) baru. 

Berdasarkan StatCounter Global Stats, pangsa pasar pengguna sistem 
operasi Mac OS kurang dari 10 persen dari pengguna global sistem operasi. 
Statistik ini jauh lebih rendah dari persentase pengguna sistem operasi 
Windows (lebih dari 80 persen). 

Salah satu penyebabnya adalah bahwa harga komputer Apple 
cenderung lebih mahal. Namun, banyak orang lebih menyukai tampilan 
sistem operasi Mac OS X daripada Windows.

Linux
Linux (diucapkan LINN-ux) adalah jenis sistem operasi open-source, yang 
kode programnya (source code) dapat dimodifikasi dan didistribusikan 
oleh siapa saja di seluruh dunia.

Sistem operasi Linux berbeda dari sistem operasi Windows yang 
bersifat proprietary (modifikasi kode program hanya dapat dilakukan oleh 
perusahaan pencipta Windows). Beberapa keuntungan Linux adalah gratis 
dan tersedia banyak varian Linux yang dapat di pilih sesuai keinginan.

Android
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1.	 Android dengan logo uniknya yaitu “Robot Ijo” sebetulnya sudah 
ada sejak lama, namun semenjak tahun 2009 perkembangan Android 
melesat dengan cepat. 

2.	 Mobile OS dari Google ini memberikan kebebasan yang sangat 
luas untuk para developer dan terintegrasi penuh dengan teknologi 
Google. 

3.	 Aplikasi-aplikasi yang tersedia untuk Android juga sudah banyak 
sekali sehingga pengguna Android mempunyai banyak variasi dalam 
menggunakan aplikasi di Android. 

Jelaskan Cara Kerja Sistem Operasi?
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Bab V
Microsoft Word

Pengenalan Microsoft Word
Microsoft Word merupakan program aplikasi pengolah kata (word 
processor) yang yang biasa digunakan untuk membuat laporan, dokumen 
berbentuk surat kabar, label surat, membuat tabel pada dokumen.

Program Microsoft Word merupakan paket program yang termasuk 
dalam kelompok Word Processing ( pengolahan kata ).

Program ini menjadi satu paket kedalam Microsoft office. Dalam 
materi ini kita akan mempelajari Microsoft Word. 

Sebetulnya masih ada lagi program pengolah kata yang beredar 
di Indonesia antara lain Word Perfect, WordStar, Chiwriter, WordPad, 
NotePad dll.

Memulai Word 
Microsoft Office Word dapat dibuka dengan menggunakan beberapa 
cara yang berbeda. Jika icon Microsoft Word terdapat pada Desktop atau 
melalui tombol Start, dapat dibuka dengan menggunakan dobel klik pada 
icon tersebut untuk membuka layar Excel
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Menjalankan dari Start
1.	 Klik tombol Start
2.	 Pilih All Programs
3.	 Pilih Microsoft Office
4.	 Pilih dan klik Microsoft Ofice Word 

 

Akses MS Word dari Start > Programs

Atau 

Menggunakan icon Microsoft Word terdapat pada Desktop

Setelah tereksekusi maka aplikasi MS Word akan dijalankan dan 
menampilkan lingkungan kerja sebagai berikut:
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Identifikasi Lembar Kerja Microsoft Word 
1.	 File Menu (Backstage) 

Klik tombol File untuk melihat menu Backstage. Pengguna dapat 
menyimpan, mencetak, atau berbagi file; memodifikasi pilihan Word, 
dan keluar dari program. 

2.	 Quick Access Tollbar 
Toolbar khusus ini menyediakan akses cepat ke perintah yang paling 
sering digunakan. 

3.	 Tittle Bar 
Nama dokumen akan muncul di sini, serta nama program. 

4.	 Windows Controls 
Dari kiri ke kanan, ini adalah Minimixe, Maximize / Restore, dan 
Close.

5.	 Tabs 
Klik nama tab untuk melihat perintah khusus untuk nama tab tersebut. 
Misalnya, tab Page Layout memungkinkan Anda mengubah ukuran 
kertas, margin, pengaturan paragraf, dan banyak lagi. Area perintah 
di bawah tab dikenal sebagai Ribbon. 
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6.	 Minimize Ribbon dan Icon Help 
Klik panah kecil di sisi kanan dari jendela untuk menyembunyikan 
pita.Klik icon tanda tanya biru untuk membuka jendela dialog 
Bantuan. 

7.	 Groups 
Perintah-perintah pada setiap tab dipisahkan ke dalam kelompok. 
Kelompok ini menyediakan perintah untuk mengubah ukuran, 
melihat, dan orientasi dari sebuah paragraf.Kadang-kadang, di sudut 
kanan bawah grup, terlihat tombol pilihan.

8.	 Working Area 
Ini adalah tempat mengisi dokumen dengan ketikan 

9.	 Scroll Bar 
Scroll bar memungkinkan untuk mencari bagian dari dokumen. 
Klik panah atas / bawah pada setiap akhir scroll bar untuk bergerak 
ke arah itu, atau klik dan tarik scroll marker untuk bergerak cepat 
melalui dokumen. Jika mouse Anda dilengkapi dengan scroll, putar 
roda ke atas atau bawah untuk menggulirkan layar. 

Diperhatikan juga bahwa jika memperbesar dokumen dan lebar 
halaman melebihi lebar jendela Word, akan terlihat horizontal scroll 
bar yang muncul didekat status bar. Gunakan ini untuk bergulir dari 
sisi kiri ke sisi kanan atau sebaliknya 

10.	 Status Bar 
Status bar memberikan informasi tentang dokumen tersebut. Status 
bar juga menunjukkan halaman atau jumlah total halaman, berapa 
banyak kata dokumen tersebut, view apa yang saat ini sedang 
digunakan, dan level zoom saat ini.

Fungsi Sub Menu Pada Menu Bar
Semua menu yang terdapat pada menu utama Microsoft word memiliki 
submenu yang mempunyai fungsi masing-masing sesuai dengan 
kelompoknya. Untuk lebih memudahkan kita bahas satu persatu.
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1.	 Ikon dan Sub Menu Dari menu File

Sub Menu
Tom-

bol
Fungsinya

New Ctrl+N Membuat dokumen baru
Open Ctrl+O Untuk membuka dokumen yang tersimpan
Close Alt+F4 Untuk menutup dokumen yang aktif
Save Ctrl+S Untuk menyimpan dokumen aktif
Save As Untuk menyimpan dokumen yang belum diberi 

nama dan
diberi kesempatan mengganti nama file

Save as Web
Page

Untuk menyimpan dokumen dalam bentuk htm

File Search Untuk mencari dokumen
Page Setup Untuk mengatur halaman yang akan dicetak
Print Preview Untuk melihat tampilan dokumen sebelum dice-

tak
Print Ctrl+P Untuk mencetak dokumen dan juga untuk men-

gatur
halaman

Send To Untuk mengirimkan dokumen
Properties Untuk membuat rangkuman dari dokumen yang 

aktif
Exit Untuk keluar dari word dan menutup seluruh do-

kumen

2.	 Ikon dan Sub Menu Dari menu Edit

Sub Menu
Tom-

bol
Fungsinya

Undo Ctrl+Z Untuk membatalkan perintah yang telah dilaku-
kan

Redo Ctrl+Y Untuk mengulangi perintah terakhir yang
pernah dibatalkan dengan Undo

Repeat Untuk mengulangi perintah yang telah dilakukan
Cut Ctrl+X Untuk memotong atau menghapus teks atau 

gambar dan
disimpan dalam clipboard
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Copy Ctrl+C Untuk mengcopy atau menyalin file, teks atau 
gambar yang
disimpan dalam clipboard

Paste Ctrl+V Untuk menampilkan teks atau gambar yang tel-
ah dicopy
atau di cut

Select All Ctrl+A Untuk memilih/menyorot seluruh teks atau 
gambar yang
akan diolah

Find Ctrl+F Untuk mencari teks atau kata dalam dokumen
Repleace Ctrl+H Untuk mengubah teks atau kata dalam dokumen
Go To Ctrl+G Untuk menuju ke halaman, footnote, endonote 

atau bagaian
lain yang ada dalam dokumen

3.	 Ikon dan Sub Menu Dari menu View
Sub Menu Tombol Fungsinya

Normal Mengubah penampilan layar pengetikan dalam 
mode
normal

Web layout Mengubah penampilan layar pengetikan dalam 
bentuk web
view

Outline Mengubah penampilan layar pengetikan dalam 
bentuk
outline

Print Layout Mengubah penampilan layar pengetikan dalam 
bentuk Print
View

Taks Pane Ctrl+F1 Untuk menampilkan dan menghilangkan taks 
pane

Toolbars Untuk menampilkan dan menghilangkan toolbars
Ruler Untuk menampilkan dan menghilangkan garis 

pengatur
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Header and
Footer

Untuk membuat judul di atas (header) dan mem-
buat judul di
bawah (footer)

Full screen Untuk menampilkan dokumen dalam satu layer 
penuh

Magnifier Untuk menampilkan dokumen berdasarkan pili-
han pembesaran layar

Zoom Untuk menentukan ukuran tampilan layar
yang ditampilkan

4.	 Ikon dan Sub Menu Dari menu Insert

Sub Menu
Tom-

bol
Fungsinya

Page Break Untuk menyisipkan belahan halaman
Page Number Untuk menyisipkan nomor halaman baik di atas 

maupun di
bawah

Date and Time Untuk meyisipkan tanggal dan jam dalam doku-
men

Symbol Untuk menyisipkan symbol ke dalam dokumen
Footnote Untuk menyisipkan catatan kaki dalam dokumen
Boolmark Untuk menyisipkan tanda pada teks atau gam-

bar, grafik
atau lainnya ke dalam dokumen

Hyperlink Ctrl+K Untuk menyisipkan teks hyperlink pada lembar 
kerja yang berguna untuk dalam pembuatan	
shortcut dalam pembukaan dokumen yang tersim-
pan di internet, jaringan

Tekx Box Untuk menyisipkan tek atau gambar pada kotak 
dalam
dokumen

File Untuk menyisipkan suatu file ke dalam dokumen
Insert Excel
Spreadshhet

Untuk menyisipkan lembar kerja excel kedalam 
dokumen
word
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Diagram Untuk menyisipkan digram/grafik kedalam doku-
men

WordArt Untuk menyisipkan teks yang mengandung seni 
kedalam
dokumen

ClipArt Untuk menyisipkan gambar ClipArt melalui Mic-
rosoft ClipArt
Gallery kedalam dokumen

Object Untuk menyisipkan objek ke dalam dokumen
Autoshapes Untuk menyisipkan gambar tertentu dari tollbar 

kedalam
dokumen

Equation Ed-
itor

Untuk menyisipkan rumus matematika kedalam 
dokumen

5.	 Ikon dan Sub Menu Dari menu Format

Sub Menu
Tom-

bol
Fungsinya

Font Untuk memilih jenis huruf yang diinginkan
Paragraph Untuk menentukan indentasi, spasi, spasi antar 

paragraph
dalam dokumen

Bullets and
Numbering

Untuk menyisipkan bullets dan nomor pada 
teks yang
terpilih dalam dokumen

Border and
Shading

Untuk membuat border atau bingkai

Column Untuk membuat dokumen menjadi beberapa 
kolom atau
membuat seperti kolom Koran

Tab Untuk menentukan posisi dari tempat berhentin-
ya tabulasi
(tab) dalam dokumen

Drop Cap Untuk membuat huruf pertama pada teks ataupun
paragraph menjadi huruf yang besar.

Text Direction Untuk merubah orientasi teks pada dokumen
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Change Case Untuk merubah teks menjadi huruf besar 
semua, kecil
semua, huruf besar pada tiap kata atau sebaliknya

Background Untuk memberi warna belakang pada lembar 
kerja yang
aktif

6.	 Ikon dan Sub Menu Dari menu Tools

Sub Menu
Tom-

bol
Fungsinya

Spelling and
Grammar

Untuk menjalankan fasilitas pemeriksaan ejaan 
dan tata
bahasa dari teks atau paragraph

Dictionary Untuk menjalankan fasilitas kamus dalam doku-
men

Grammar Untuk pengaturan tata bahasa dalam dokumen
Word Count Untuk memberikan data statistic tentang jum-

lah halaman, kata, karakter, paragraph atau baris 
pada dokumen yang
aktif

AutoCorrect Untuk memperbaiki teks secara otomatis
Track Change Untuk melihat pengubahan pada dokumen 

yang telah
dilakukan, menerima atau menolak pengubahan 
yang telah dilakukan

Compare
Documents

Untuk membandingkan dokumen yang aktif 
dengan
dokumen lainnya

Merge Docu-
ments

Untuk menggabungkan dokumen aktif yang tel-
ah diubah oleh track changes ke dalam dokumen 
yang telah
dispesifikasikan

Protect
Documents

Untuk melindungi dokumen agar aman dari
pengubahan didalam dokumen
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7.	 Ikon dan Sub Menu Dari menu Table

Sub Menu
Tom-

bol
Fungsinya

Insert Untuk menyisipkan table baru ke dalam doku-
men, menyisipkan kolom baris serta sel

Delete Table Untuk menghapus table
Delete Rows Untuk menghapus baris
Delete Col-
umn

Untuk menghapus kolom

Delete Cells Untuk menghapus sel
Select Tabel Untuk memilih atau menyeleksi table
Select Rows Untuk memilih atau menyeleksi baris
Select Column Untuk memilih atau menyeleksi kolom
Select Cells Untuk memilih atau menyeleksi sel
TableAutoFor-
mat

Untuk membuat format table secara otomatis

Merge Cells Untuk menggabungkan beberapa kolom atau 
baris

Split Cells Untuk membagi kolom menjadi beberapa baris 
dan kolom

Split Table Untuk membagi table menjadi dua table
Sort Untuk mensortir data atau mengurutkan data
Formula Untuk memasukkan rumus dalam melakukan 

perhitungan pada table
Hide Gridlines Untuk menampilkan atau menyembunyikan garis 

Bantu

8.	 Ikon dan Sub Menu Dari menu Window dan Help

Sub Menu
Tom-

bol
Fungsinya

New window Untuk memperlihatkan dokumen yang sama da-
lam jendela yang berbeda

Arrange All Untuk mengatur jendela dari dokumen aktif agar 
dapat melihat seluruh dokumen aktif dalam wak-
tu yang sama
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Split Untuk membagi menjadi dua bagianpada doku-
men aktif, agar dapat melihat bagian yang berbe-
da pada waktu yang sama

About Micro-
soft Word

Untuk menampilkan kotak dialog tentang Mic-
rosoft word yang kalian gunakan dan seterusnya.

Fungsi Ikon Pada Toolbar Standart

Ikon
Nama

Tombol
Kegunaan

New Blank
Docu-
ments

Untuk membuat dokumen baru

Open Untuk membuka dokumen yang tersimpan

Save Untuk menyimpan dokumen yang masih aktif

Permission
Untuk mengaktifkan & dan menonaktifkan network 
dari satu komputer dengan komputer lain

e-Mail Untuk mengirinkan data melalui e-mail

Print Mencetak dokumen / data

Print
preview

Melihat dokumen sebelum dicetak

Spelling
Untuk mengecek kebenaran pengejaan tulisn yang sudah 
diketik sesuai dengan bahasa yang sudah kita setting

Research Untuk mencari file atau dokumen yang diinginkan

Cut Mengggunti obyek

Copy Membuat duplikat

Paste
Mengambil data dari clipboard setelah di copy atau dicut
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Format
Painter

Mengcopy format yang sudah diketik

Undo Membatalkan perintah

Redo Mengembalikan setelah di ndo

Hyperlink Untuk menyisipkan hyperlink

Table and
Border

Untuk membuat table dan border

Insert Ta-
ble

Untuk menyisipkan table pada dokumen

Insert Mic-
rosoft Excel
Worksheet

Untuk menyisipkan lembar kerja Excel ke dalam dokumen 
Microsoft Word

Column Untuk membuat kolom koran

Chart
wizard

Menyisipkan grafik / membuat grafik pada dokumen

Zoom Untuk mengatur tampilan dokumen

Fungsi Ikon Pada Toolbar Formatting

Ikon
Nama

Tombol
Kegunaan

Font Memilih jenis atau bentuk huruf / font

Font Size Memilih ukuran huruf / font

Bold Membuat huruf tebal

Italic Membuat huruf miring

Underline Membuat huruf bergaris bawah
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Align left Meletakkan data rata kiri sel

Center Meletakkan data di tengah sel

Align 
Right

Meletakkan data rata kanan sel

Justify Untuk membuat teks, paragraph rata kiri dan kanan

Line Spac-
ing

Untuk mengatur jarak spasi antar baris

Number-
ing

Untuk membuat memberi nomor para baris / paragraph

Bullets Untuk memberikan symbol pada baris / paragraf

Decrease 
indent

Mengurangi Indentasi

Increase 
indent

Menambah Indentasi

Borders Memberi borders / garis pada tabel

Fill color Memberi warna pada background

Font color Memberi warna pada huruf / font

Fungsi Ikon Pada Toolbar Drawing

Ikon
Nama
Tombol

Kegunaan

Select Untuk memilih obyek

Untuk menggambar Autoshapes

Ikon
Nama
Tombol

Kegunaan

Line Untuk membuat/menggambar garis
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Arrow Untuk membuat atau menggambar panah

Rectangle Untuk menggambar kotak

Oval Untuk menggambar lingkaran

Text Box
Untuk menyisipkan tek atau gambar pada kotak dalam 
dokumen

Insert 
WordArt

Untuk menyisipkan teks yang mengandung seni dalam 
dokumen

Insert Dia-
gram

Untuk menyisipkan diagram arganisasi ke dalam doku-
men

Insert Cli-
pArt

Untuk menyisipkan gambar ClipArt melalui ClipArt 
Gallery kedalam dokumen

Insert Pic-
ture

Untuk menyisipkan gambar melalui kedalam dokumen

Fill Color Untuk memberi warna pada obyek gambar

Line Color Untuk memberi warna pada gambar garis

Font Color Untuk memberi warna pada huruf atau font

Line Style Untuk memilih bentuk gambar garis

Dash Style Untuk memilih model garis

Arrow 
Style

Untuk menganti bentuk gambar panah

Shadow 
Style

Untuk memberikan shadow pada obyek gambar
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3-D Style Untuk memilih bentuk gambar 3 dimensi

Editing Naskah 
Melakukan editing pada naskah dapat dilakukan dengan mudah seperti 
melakukan perbaikan teks, menghapus teks, menyisipkan teks, memin-
dahkan teks bahkan menyalin teks, kalimat atau paragraf dari satu posisi 
ke posisi lainnya. 
1.	 Cara click pada mouse

a.	 Single click: menekan tombol mouse satu kali (tekan + lepas). 
b.	 Double click: menekan dengan cepat tombol mouse sebanyak 2 

kali (tekan + lepas + tekan +lepas) 
c.	 3. Hold click: menekan tombol mouse lalu ditahan beberapa 

waktu kemudian dilepas untuk mengakhirinya (tekan + tahan 
+ lepas) 

2.	 Menempatkan kursor pada posisi tertentu 
a.	 Geser penunjuk mouse pada posisi yang akan ditempatkan kursor 
b.	 Lakukan single click pada posisi tersebut 

3.	 Menandai teks / Membuat Blok pada teks 
a.	 Tempatkan kursor pada awal teks yang akan diblok 
b.	 Lakukan hold click sambil menggeser mouse hingga akhir teks 

yang akan diblok 
4.	 Menghilangkan tanda blok pada teks dengan cara click pada 

sembarang tempat/posisi.
5.	 Menghapus teks 

a.	 Untuk menghapus satu karakter arahkan kursor pada teks yang 
akan dihapus 

b.	 Tombol Backspace: Digunakan untuk menghapus karakter yang 
terletak di belakang kursor 

c.	 Tombol Delete: Untuk menghapus karakter yang berada di depan 
posisi kursor 
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d.	 Menghapus lebih dari satu karakter sekaligus Blok teks yang akan 
dihapus Tekan tombol Delete 

6.	 Memperbaiki teks 
a.	 Tempatkan kursor pada teks yang akan diperbaiki 
b.	 Hapus karakter yang akan diperbaiki 
c.	 Ketik teks yang menjadi perbaikannya 

7.	 Menyisipkan teks 
a.	 Tempatkan kursor pada posisi yang akan disisipkan teks baru 
b.	 Ketiklah teks yang menjadi sisipannya 

8.	 Mengganti satu blok teks 
a.	 Blok teks yang akan diganti 
b.	 Tulislah teks baru 

9.	 Menyalin teks dari satu posisi ke posisi lainnya 
a.	 Buatlah blok pada teks yang akan disalin 
b.	 Click Copy pada Clipboard Group di Home Tab atau tekan Ctrl 

+ C 
c.	 Letakkan kursor pada posisi yang akan ditempatkan salinan teks 

tersebut 
d.	 Click Paste pada Clipboard Group di Home Tab atau tekan Ctrl 

+ V 
10.	 Memindahkan teks dari satu posisi ke posisi lainnya 

a.	 Buatlah blok pada teks yang akan dipindahkan 
b.	 Click Cut pada Clipboard Group di Home Tab atau tekan Ctrl + X 
c.	 Letakkan kursor pada posisi yang akan ditempatkan teks tersebut 
d.	 Click Paste pada Clipboard Group di Home Tab atau tekan Ctrl 

+ V

Membuat Table
Untuk membuat table biasanya kita lebih mudah dengan menggunakan 
Microsoft Excel. Akan tetapi Microsoft Word juga menyediakan fasilitas 
untuk membuat sebuah table. Dimana dalam pembuatan table-nya 
terhitung lebih mudah daripada dengan menggunakan Word.
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Langkah – Langkah pembuatan table:
1.	 Klik menu Insert pada ribbon
2.	 Pilih icon table, kemudian Insert Table

Dalam pembuatan sebuah table disediakan beberapa menu tambahan, 
antara lain:
1.	 Insert - Dengan menu Insert kita dapat menambahkan kolom, baris, 

dan cell pada saat pembuatan table.Langkah-Langkah: Klik kanan 
pada table à Insert à Insert …… (sesuai yg anda inginkan)

2.	 Merge - Dengan Merge kita dapat menggabungkan beberapa kolom/
baris menjadi satu. 
a.	 Block baris atau kolom yg anda inginkan terlebih dahulu. 
b.	 Klik kanan à Merge Cells

3.	 Table properties, digunakan untuk mengatur tampilan table. 
a.	 Block tabel terlebih dahulu
b.	 Klik kanan à Table Properties

Menutup Word 
Bila sudah selesai bekerja dengan sebuah file, pengguna dapat menutup 
file tersebut dengan memilih menu Tab File dan click pada tombol Close 
atau dapar juga dengan click pada tombol Exit (hanya jika ingin keluar 
dari Word). 
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Pertanyaan

Ikon
Nama
Tombol

Kegunaan

………….. [ A ] Membuat gambar lingkaran

…………..
[ B ] Untuk memberikan warna pada huruf atau 
font

…………..
[ C ] Untuk membuat teks atau kalimat rata di 
tengah

………….. [ D ] Untuk memberi warna pada garis

…………..
[ E ] Untuk melihat / menapilkan dokumen sebe-
lum dicetak

………….. [ F ] Untuk membuat teks atai tulisan miring

…………..
[ G ] Untuk menyisipkan lembar kerja Excel ke 
dalam dokumen	 Microsoft Word

…………..
[ H ] Untuk menampilkan obyek dari clipboard 
setelah di copy atau di cut

…………..
[ I ] Untuk menyisipkan tulisan indah ke dalam 
dokumen

………….. [ J ] Untuk menyimpan dokumen

………….. [ K ] Digunakan untuk membuat dokumen baru

…………..
[ L ] Untuk menyisipkan teks atau gambar dalam 
kotak

…………..
[ M ] Untuk memberikan angka pada kalimat 
dlam dokumen aktif

…………..
[ N ] Untuk memberikan garis bawah pada kali-
mat atau teks
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…………..
[ O ] Untuk memberikan shadow pada obyek 
gambar
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Bab VI
Microsoft Powerpoint

Pengenalan Microsoft Powerpoint
Micorosoft PowerPoint adalah program aplikasi untuk membuat presentasi 
secara elektronik yang handal. Presentasi Power Point dapat terdiri dari 
teks, grafik, objek gambar, clipart, movie, suara dan objek yang dibuat 
program lain.

Program ini pun dapat dicetak secara langsung menggunakan kertas, 
atau dengan menggunakan transparansi untuk kebutuhan presentasi 
melalui Overhead, serta dapat dicetak untuk ukuran slide film. Apabila 
dibutuhkan dibagikan kepada audiens sebagai bahan pendukung dalam 
presentasi, maka kita dapat mencetaknya seperti notes, handout dan 
outline. 

Mengaktifkan Ms. PowerPoint
Langkah pertama yang harus dilakukan adalah mengaktifkan Ms. Power 
Point yang ada di komputer:

Klik START, pilih Program, pilih Microsoft Office, dan kemudian 
klik Power Point.
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Posisi menu bisa saja tidak sama antara satu komputer dengan 
komputer lainnya, Jika sudah membuat shortcut dan menempatkannya 
pada desktop, maka dapat mengaktifkan Ms. PowerPoint dengan mengklik 
(double click) icon shortcut tersebut.

Lembar Kerja Ms. PowerPoint
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1.	 Tombol File
Di sudut kiri atas adalah tombol Microsoft Office. Ketika Kita 
mengklik tombol, menu muncul. Kita dapat menggunakan menu 
untuk membuat file baru, membuka file yang sudah ada, menyimpan 
file, dan melakukan tugas-tugas lainnya. 

2.	 Akses Cepat 
Sebelah tombol Microsoft Office adalah Akses Cepat toolbar.  Akses 
Cepat toolbar memberikan Kita akses ke perintah paling sering Kita 
gunakan.  Secara default, Save, Undo, Redo dan muncul di toolbar 
Akses Cepat.  Kita menggunakan Simpan untuk menyimpan file Kita, 
Undo untuk melakukan rollback tindakan telah diambil, dan Redo 
mengajukan permohonan kembali tindakan Kita telah dibatalkan. 

3.	 Title Bar 
Judul bar terletak di bagian atas di tengah jendela PowerPoint.  Judul 
bar menampilkan nama dari presentasi di mana Kita saat ini bekerja.  
Secara default, nama presentasi PowerPoint secara berurutan, dimulai 
dengan Presentation1.  Ketika Kita menyimpan file Kita, Kita dapat 
mengubah nama presentasi Kita. 

4.	 Ribbon 

Ket. (1)Tab; (2) Grup Komando; (3) Tombol Perintah; (Launcher)

Kita menggunakan perintah untuk memberitahu PowerPoint apa 
yang harus dilakukan.  Dalam PowerPoint, Kita menggunakan Ribbon 
untuk mengeluarkan perintah.  Ribbon terletak di dekat bagian atas 
jendela PowerPoint, di bawah toolbar Akses Cepat.  

Di bagian atas Ribbon adalah beberapa tab, klik tab menampilkan 
beberapa kelompok perintah yang terkait.  Dalam setiap kelompok 
terkait tombol perintah.  Kita klik tombol untuk mengeluarkan 
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perintah atau untuk mengakses menu dan kotak dialog.  Kita juga 
dapat menemukan sebuah peluncur kotak dialog di pojok kanan 
bawah kelompok.  Ketika Kita mengklik peluncur kotak dialog, kotak 
dialog membuat perintah tambahan yang tersedia. 

5.	 Penggaris

Penggaris adalah panduan vertikal dan horisontal.  Kita menggu-
nakan mereka untuk menentukan di mana Kita ingin menempatkan 
obyek.  Jika penggaris tidak muncul di jendela PowerPoint Kita: 

Klik tab View.

Klik ruler di Tampilkan / Sembunyikan grup.  Para penggaris muncul.

6.	 Slides, penampung, dan Catatan 

Ket. (1) Slide; (2) Placeholders;(3) Notes

Slide muncul di tengah jendela.  Kita menciptakan pada slide 
presentasi Kita.   Penampung terus objek dalam slide Kita.  Kita dapat 
menggunakan penampung untuk menahan teks, clip art, grafik, 
dan banyak lagi.  Kita dapat menggunakan catatan daerah untuk 
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menciptakan catatan untuk diri sendiri.  Kita dapat merujuk ke 
catatan tersebut saat Kita memberikan presentasi Kita.

7.	 Status Bar, Tabs, Buttons Lihat, dan Lainnya 

a.	 Status Bar
b.	 Garis Besar Tab
c.	 Slides Tab
d.	 Lihat Buttons
e.	 Zoom
f.	 Vertikal & Horizontal Bar Splitter
g.	 Minimalkan Button 
h.	 Maksimalkan / Tombol Restore
i.	 Close Button

Status bar yang umumnya muncul di bagian bawah jendela. Status 
bar akan menampilkan jumlah slide yang sedang ditampilkan, jumlah 
slide, dan nama desain template digunakan atau nama belakang. 
Menampilkan tab Outline teks yang terdapat dalam presentasi Kita.  
Slides tab menampilkan thumbnail dari semua slide Kita. Kita klik 
thumbnail untuk melihat slide dalam Slide pane. 
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Memulai presentasi baru 
Kita bisa mulai presentasi baru yang kosong dari slide, template, ada 
presentasi, atau Power Point outline. 

1.	 membuat presentasi baru yang kosong:
Klik Tombol ‘Microsoft File’ 

Klik ‘New’ >Klik ‘Blank Presentation’

2.	 Untuk membuat presentasi baru dari template:
Klik Tombol ‘Microsoft File > Klik ‘New’ > Klik ‘Installed Templates 
atau Browse’ > Klik ‘template’ yang Kita pilih 

Penyimpanan Presentasi
Bila Kita menyimpan presentasi, Kita memiliki dua pilihan: Simpan atau 
Simpan Sebagai. Untuk menyimpan dokumen: Klik Tombol ‘Microsoft 
File’ > Klik ‘Save’

http://belajarpowerpoint.blogspot.com/2009/04/cara-buat-presentasi-baru-power-point.html
file:///D:/2024/1.%20Januari/Bahan%20Ajar%20Aplikasi%20Komputer/javascript:void(0);
file:///D:/2024/1.%20Januari/Bahan%20Ajar%20Aplikasi%20Komputer/javascript:void(0);
file:///D:/2024/1.%20Januari/Bahan%20Ajar%20Aplikasi%20Komputer/javascript:void(0);


Frizka Fitriana, S.Kom., M.Kom. 53

 

Kita mungkin harus menggunakan fitur Save As bila Kita perlu 
menyimpan presentasi dengan nama yang lain atau menyimpannya untuk 
PowerPoint versi sebelumnya. Untuk menggunakan fitur Save As:

Klik Tombol ‘Microsoft File’ > Klik ‘Save As’ > Ketik nama untuk 
Presentasi Dalam kotak Simpan. 

 

Penambahan Slides
Ada beberapa pilihan bila Kita ingin menambahkan slide baru ke dalam 
presentasi: Office Themes, Duplicate Selected Slide, atau Reuse Slides.
1.	 Untuk membuat slide baru dari Office Themes: 

Pilih slide SEBELUM segera di mana Kita ingin slide baru
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Klik tombol ‘New Slide’ pada tab Home
Klik slide yang sesuai pilihan Kita 

2.	 Untuk membuat slide sebagai duplikat dari slide dalam presentasi:
Pilih slide untuk menduplikasi
Klik tombol ‘New Slide’ pada tab Home > Klik ‘Duplicate Selected 
Slides’  
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3.	 Themes/Tema
Tema tersebut adalah desain template yang dapat diterapkan untuk 
seluruh presentasi yang memungkinkan untuk konsistensi seluruh 
presentasi. Untuk menambahkan tema untuk presentasi:

Klik tab ‘Design’ > Pilih salah satu yang ditampilkan Tema atau klik 
tombol Galleries 

Format Dokumen
Agar presentasi yang kita buat bener-benar sempurna dan layak untuk 
ditampilkan, harus melakukan pengeditan dan pemformatan. Dalam 
pembuatan presentasi akan bekerja dengan teks, table, slide dan elemen-
elemen presentasi lain.
1.	 Bekerja dengan Teks

Teks merupakan elemen presentasi yang paling penting. Agar 
presentasi kita menarik dan membantu Anda dalam menjelaskan 
sesuatu, maka teks yang singkat, padat, jelas dan menarik sangat 
berperan penting.

2.	 Menambahkan Teks
Pilih slide di mana Anda ingin memasukkan teks, Klik di Textbox 
untuk menambahkan teks
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3.	 Penambahan teks box
Pilih slide yang Anda inginkan untuk menempatkan teks box Pada 
tab Insert, klik Text Box Klik pada slide dan tarik kursor untuk 
memperluas teks box Ketik teks  

4.	 Pengaturan Teks 
a.	 Font typeface:

Klik panah di sebelah nama font dan pilih font. Ingat bahwa Anda 
dapat melihat bagaimana font baru akan terlihat oleh penyorotan 
teks, dan hovering melalui font typeface baru.  

b.	 Mengubah ukuran font:
Klik panah di sebelah font size dan pilih ukuran yang sesuai, atau 
Klik pada tombol increase or decrease font size. 
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c.	 Font Styles dan Efek
Font style format standar adalah pilihan yang digunakan untuk 
menekankan teks. Mereka termasuk: Bold, Italic, dan Underline. 
Untuk menambahkan teks ke ini: Pilih teks dan klik font Styles 
disertakan pada font grup dari tab Home atau Pilih teks dan klik 
kanan untuk menampilkan pengaturan font

d.	 Ganti Warna Teks
Untuk mengubah warna teks: Pilih teks dan klik tombol Warna 
yang ada pada font Group dari Ribbon, atau Sorot teks dan 
klik kanan dan memilih pengaturan warna. Pilih warna dengan 
mengklik panah bawah di samping tombol warna font. 

Video, Audio Dan Animasi

1.	 Video
Klip video dapat ditambahkan ke dalam presentasi. Untuk 
menambahkan klip video: Klik tombol Movie pada tab Insert >Pilih 
Movie from File atau Movie from Clip Organizer

2.	 Audio
Audio klip dapat ditambahkan ke dalam presentasi. Untuk menambah 
klip audio: Klik tombol Audio pada tab Insert > Pilih dari file suara, 
Sound from File, Sound from Clip Organizer, Play CD Audio Track, 
atau Record Sound  
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3.	 Transisi 
Transisi adalah efek yang berada di tempat saat Anda beralih dari 
satu slide ke slide berikutnya. Untuk menambahkan slide transisi:

Pilih slide yang ingin Anda transisi > Klik tab animations 
Pilih animasi yang sesuai atau klik kotak dialog Transisi 

4.	 Slide Animation
Slide efek animasi standar adalah efek khusus yang dapat ditambahkan 
ke objek pada slide. Untuk menerapkan efek animasi:

Pilih objek > Klik tab Animations pada Ribbon > Klik Custom 
Animation > Klik Add Effect > Pilih efek yang sesuai 

5.	 Preview Animasi
Untuk melihat animasi pada slide: Klik tombol Preview pada tab 
animation 

6.	 Membuat Link
a.	 Seleksilah teks, gambar, clip art atau place holder yang akan 

Anda Link.
b.	 Kemudian, Klik Ribbon Tab Insert, lalu pilih Hyperlink
c.	 Maka, akan mucul jendela dialog seperti berikut:

1)	 Existing File or Web Page: Anda me-link pada file yang 
telah ada sebelumnya, yang di simpan pada folder tertentu. 

file:///D:/2024/1.%20Januari/Bahan%20Ajar%20Aplikasi%20Komputer/javascript:void(0);
file:///D:/2024/1.%20Januari/Bahan%20Ajar%20Aplikasi%20Komputer/javascript:void(0);
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Atau Anda melakukan link ke alamat web tertentu dengan 
menuliskan alamat web tersebut pada Address Bar.

2)	 Current Folder: Link pada file yang ada pada folder dimana 
file kita ada.

3)	 Browsed Page: Memilih link pada drive/folder dimana folder 
kita berada

4)	 Recent File: Muncul file-file yang bisa kita pilih untuk di link
5)	 Place in This Document: Anda melakukan link pada slide 

presentasi yang sama yang sudah Anda buat sebelumnya.
6)	 Create New Document: Membuat document baru yang akan 

kita link dengan slide presentasi yang kita tentukan.
7)	 E-mail Address: Link pada alamat email tertentu.

d.	 Untuk pilihan link berdasarkan slide yang kita pilih, maka kita 
melakukan link pada slide lain yang ada pada file presentasi 
kita (Place in This Document). Teks yang sudah ter-link akan 
berwarna biru dan bergaris bawah.

e.	 Melakukan Link pada file lain yang ada di folder (misalkan link 
ke format document)

f.	 Mencoba aktif tidaknya link yang kita buat. 
Untuk melihat aktif tidaknya link yang kita buat, maka kita 
harus menjalankan slide presentasi yang telah kita buat tersebut. 
Caranya:
1)	 Mengaktifkan ribbon tab slide show dan memilih salah satu 

pilihan pada ribbon start slide show.
2)	 Mengklik tombol yang ada di bagian bawah, untuk 

menampilkan halaman yang sedang aktif.

g.	 Untuk setiap halaman yang menjadi link bagi menu utama dari 
slide, harus membuat link kembali ke menu utama, atau menu 
tertentu sesuai dengan yang di inginkan.
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Menjalankan Presentasi 
Saat menjalankan presentasi pada layar komputer (on-screen), seluruh 
layar akan digunakan dan komponen-komponen layar seperti toolbar, 
menu, dan lain-lain akan hilang dari layar. Cara menjalankan presentasi 
ini cukup sederhana, buka presentasi yang akan dijalankan, lalu klik menu 
View, Slide Show atau menu Slide Show, View Show

Cetak Handout Presentasi
Pencetakan Langkah-langkahnya adalah Klik tombol File pada pojok 
kiri atas tampilan Klik print kemudian pilih print, Isi menu print sesuai 
kebutuhan anda
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Bab VII
Microsoft Excel

Pengenalan Microsoft Excel
Microsoft Office Excel adalah aplikasi spreadsheet (lembar kerja) yang 
powerful dan mudah digunakan. Hampir semua orang yang bekerja 
dengan angka memiliki kemungkinan menggunakan Excel atau aplikasi 
spreadsheet lain (seperti Lotus 1-2-3) dalam satu bentuk atau lainnya. 

Microsoft Excel adalah salah satu program untuk mengolah data yang 
berupa angka dalam bentuk baris dan kolom atau lebih dikenal dengan 
sebutan worksheet (lembar kerja). Perangkat lunak aplikasi spreadsheet, 
pada umumnya tergabung dalam paket perangkat lunak Microsoft Office.

Excel dapat digunakan untuk membuat dan memformat workbook 
untuk menganalisis data dan membuat lebih banyak informasi dalam 
pengambilan keputusan. Secara khusus, Excel dapat digunakan untuk 
melacak data, membangun model untuk menganalisis data, menulis 
rumus untuk melakukan perhitungan pada data tersebut, pivot data dalam 
berbagai cara, dan menyajikan data dalam berbagai grafik agar terlihat 
profesional.

Perkembangan pengolah data lembar kerja (worksheet), dimulai sejak 
diperkenalkannya supercalc, Lotus 123, Open Ofice org Calc, dll. dan yang 
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terakhir ini adalah Microsoft Excel yang banyak digunakan di kalangan 
masyarakat, pelajar, mahasiswa, dan pegawai dilingkungan perkantoran

Lembar kerja Microsoft Excel terdiri dari 1.048.576 baris, yang 
digambarkan dengan nomor 1 hingga 1.048.576, dan 16.384 kolom yang 
digambarkan dengan huruf A hingga XFD. Setiap titik pertemuan antara 
kolom dengan baris disebut dengan istilah sel (cell), yang masing-masing 
dapat diisi dengan data.

Membuka Excel
Microsoft Office Excel dapat dibuka dengan menggunakan beberapa 
cara yang berbeda. Jika icon Microsoft Excel terdapat pada Desktop, 
dapat dibuka dengan menggunakan dobel klik pada icon tersebut untuk 
membuka layar Excel.

Dapat juga membuka Excel dengan cara Klik Start - All Programs - 
Microsoft Office - Microsoft Excel
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Lembar Kerja Microsoft Excel

Lembar kerja excel yang terdiri dari baris dan kolom dapat merupakan 
sebagai basis data dimana baris merupakan record yang terdiri dari 
beberapa kolom (A s/d IV), sedangkan sel merupakan field. Lembar kerja 
excel mudah dioperasikan karena menu-menu (tools) tersedia dengan 
lengkap kita tinggal pilih (user friendly)
1.	 Column, merupakan kolom pada sebuah spreadsheet, dengan 

representasi huruf, dimulai dari A sampai dengan IV
2.	 Row, merupakan baris pada sebuah spreadsheet, dengan representasi 

angka, dimulai dari 1 sampai dengan 65536
3.	 Cell, merupakan bagian terkecil, sebagai tempat penulisan baik teks, 

angka, maupun symbol.
4.	 Name Box, merupakan kotak yang menujukkan letak cell yang sedang 

aktif
5.	 Formula Bar, merupakan kotak yang menggambarkan isi cell aktif, 

bisa isi sebenarnya maupun berupa formula (operasi dan fungsi).
6.	 Sheet, bisa diartikan sama dengan page pada dokumen, namun secara 

default MS- Word akan menampilkan 3 (tiga) sheet.
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Memasukkan Data ke Lembar Kerja 
Berbagai jenis data dapat dimasukkan ke dalam lembar kerja seperti teks, 
nilai, tanggal, jam dan lain sebagainya. Untuk memasukkan data ke dalam 
suatu sel, dapat mengikuti langkah berikut ini: 
1.	 Pilih atau klik sel tempat anda akan memasukkan data 
2.	 Ketikkan data yang ingin dimasukkan 
3.	 Tekan Enter atau tombol arah panah atau tombol PgUp dan PgDn 

Memperbaiki Kesalahan Pengetikan 
Bila ada kesalahan pengetikan data, anda dapat memperbaikinya dengan 
mengikuti langkahlangkah berikut ini: 
1.	 Pilih sel yang datanya ingin diperbaiki, lalu tekan F2. Atau klik tombol 

kiri maouse 2 kali pada sel yang datanya ingin diperbaiki. 
2.	 Selanjutnya perbaiki data yang salah tersebut dan tekan tombol Enter 

bila sudah selesai. 

Menggunakan Rumus 
Anda dapat memasukkan rumus yang berupa instruksi matematika ke 
dalam suatu sel pada lembar kerja. Operator hitung yang dapat digunakan 
diantaranya adalah + (penjumlahan), －(pengurangan), * (perkalian), dan 
^ (perpangkatan). 

Penjumlahan
Operasi penjumlahan dilakukan dengan operan satu atau dua cell dan 
operator jumlah (+).

Contoh: Isi cell C1 berisi penjumlahan antara cell A1 dan B1, sehingga 
pada cell C1 diisi dengan cara = A1 + B1 Isi cell C1 berisi penjumlahan 
antara cell A1 dan bilangan 10, sehingga pada cell C1 diisi dengan cara 
= A1 + 10

Pengurangan
Operasi pengurangan dilakukan dengan operan satu atau dua cell dan 
operator kurang (-).
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Contoh: Isi cell C1 berisi pengurangan cell A1 oleh B1, sehingga pada 
cell C1 diisi dengan cara à = A1 -B1 Isi cell C1 berisi pengurangan cell A1 
oleh bilangan 5, sehingga pada cell C1 diisi dengan cara = A1 – 5

Perkalian
Operasi perkalian dilakukan dengan operan satu atau dua cell dan operator 
kali (*).

Contoh:
Isi cell C1 berisi perkalian antara cell A1 dan B1, sehingga pada cell C1 
diisi dengan cara = A1 * B1 Isi cell C1 berisi perkalian antara cell A1 dan 
bilangan 1%, sehingga pada cell C1 diisi dengan cara = A1 * 1%

Pembagian
Operasi pembagian dilakukan dengan operan satu atau dua cell dan 
operator bagi (/). Contoh:

Isi cell C1 berisi pembagian cell A1 oleh B1, sehingga pada cell C1 diisi 
dengan cara = A1 / B1 Isi cell C1 berisi pembagian cell A1 oleh bilangan 
3, sehingga pada cell C1 diisi dengan cara = A1 / 3

Pangkat
Operasi penjumlahan dilakukan dengan operan satu atau dua cell dan 
operator pangkat (^). Contoh: Isi cell C1 berisi pangkat cell A1 oleh B1, 
sehingga pada cell C1 diisi dengan cara = A1 ̂  B1 Isi cell C1 berisi pangkat 
cell A1 oleh bilangan 10, sehingga pada cell C1 diisi dengan cara = A1 ̂  10

Membuat Range/Blok Sel 
Pada saat bekerja menggunakan Excel, kita tidak hanya bekerja dalam 
satu sel saja. Terkadang, anda akan bekerja dalam grup/kumpulan sel. 
Misalnya saja bila anda ingin merubah jenis huruf beberapa kolom dan 
(atau) baris, ingin merubah rumus beberapa kolom dan (atau baris), 
copy-paste atau mendelete data beberapa kolom dan(atau) baris, dll. 
Dalam kondisi2 seperti ini, anda dapat menggunakan range/blok sel ini 
untuk memudahkan kerja anda. Range dinamakan menurut alamat sel 
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di ujung kiri atas sampai ujung kanan bawah. Sebagai contoh, range dari 
sel B2 sampai E7 dituliskan sebagai range B2:E7.

Menghapus Data 
Untuk menghapus data di suatu sel atau range tertentu, pindahkan sel ke, 
atau buatlah range tempat yang ingin dihapus, lalu tekan tombol Delete. 
Dan bila ingin menghapus format tampilan data/sel dapat dilakukan 
dengan memilih dan mengklik menu Edit, Clear, Formats. 

Memasukkan Rangkaian Data dengan Fasilitas AutoFill 

Untuk memasukkan data berupa angka atau teks dengan fasilitas 
AutoFill, dapat dilakukan dengan mengikuti langkah2 berikut ini: 

1.	 Pilih/klik sel tempat posisi awal dari rangkaian data yang ingin anda 
buat. Misalnya pilih/klik sel B2. 

2.	 Ketik data awal yang anda inginkan. Misalnya teks “Jan” (January) 
3.	 Pada sel berikutnya (sel dibawah/B3 atau disampingnya/C2) ketik 

data berikutnya yang anda inginkan. Misalnya di B3 ketik “Feb” 
(February) 

4.	 Sorot/bloklah B2:B3.
5.	 Dalam keadaan masih tersorot, arahkan penunjuk/pointer mouse ke 

pojok kanan bawah sel B3 hingga tanda plus putih berubah menjadi 
plus hitam 

6.	 Tekanlah tombol kiri mouse dan geser/drag posisi pointer mouse ke 
sel yang diinginkan misalnya B12. Dengan ini rangkaian data angka 
dapat ditampilkan.



Frizka Fitriana, S.Kom., M.Kom. 67

Jenis Data Dalam Worksheet (lembar kerja) Excel
Format Cells, yang menunjukkan jenis data dalam sel ada 12 macam

Pada umumnya format sel (data) yang biasa digunakan ada 3 (tiga) 
jenis yaitu:
1.	 Label, berupa potongan teks/naskah, ciri khas: rata kiri, tengah 

(centre), rata kanan
2.	 Angka (numeric), berupa bilangan/ angka dengan ciri khas rata 

kanan, tetapi juga dapat diatur untuk rata kiri, tengan (center), dan 
rata kanan

3.	 Rumus (formula) yang selalu diawali dengan tanda = atau @

Membuat Lembar Kerja Baru
Membuat lembar kerja baru (file baru)
1.	 Klik menu file
2.	 Pilih New (Ctrl + N)
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Menyimpan Lembar Kerja (File)
Cara melakukan penyimpanan file pada MS-Excel, langkah-langkah untuk 
menyimpan dan memberi nama file:
1.	 Klik menu File, pilih Save As. Jika mouse tidak berfungsi gunakan 

Alt + F + A, atau jika dokumen belum pernah disimpan sebelumnya 
gunakan saja Ctrl + S.

2.	 Tentukan tempat file disimpan, pilih Save in (Alt + i) dan tentukan 
di mana file dokumen akan disimpan.
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3.	 Tentukan tipe file yang akan disimpan, dengan mengisi text field di 
sebelah kanan Save as type (Alt + t), untuk MS-Excel menggunakan 
type Microsoft Excel Workbook (*.xls). Untuk menemukan alternative 
tipe penyimpanan klik panah atau gunakan panah ke bawah pada 
keyboard.

4.	 Jika langkah 1-3 sudah selesai dilakukan, klik Save (Alt + S) atau tekan 
Enter pada keyboard.

5.	 Jika Workbook telah diisi, lakukan penyimpanan secara berkala klik 
File > Save (Ctrl + S atau Alt + F + S). Sedangkan untuk menyimpan 
dengan nama lain gunakan langkah-langkah seperti saat pemberian 
nama.

Menutup Lembar Kerja
Setelah selesai bekerja, untuk mengakhiri (menutup), dapat menggunakan 
beberapa cara diantaranya adalah:
1.	 Menggunakan menu File > Close (Alt + F + C). akan muncul 

pertanyaan apakah file akan disimpan sebelum ditutup, klik yes jika 
ingin disimpan dan no jika tidak akan disimpan (Gambar diatas)

2.	 Klik tanda silang ( X ) pojok kanan atas bagian bawah. à Klik yes jika 
ingin menyimpan dokumen dan klik no jika tidak ingin menyimpan

Membuka lembar kerja (open file)
1.	 Klik menu file, pilih open atau tekan Ctrl + O, hingga muncul menu 

seperti dalam gambar di bawah ini.
2.	 Cari nama file yang akan dibuka.

Formating, Editing
Editing Data untuk Baris dan Kolom

Cells Pointer yang biasa digunakan untuk editing kolom dan baris seperti 
yang tercantum dalam tabel di bawah ini
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Tombol Keterangan

Pointer untuk memilih sel kiri, kanan, atas, atau bawah satu sel

End + 
Cursor akan pindah ke sel baris pertama (1) à misalnya dari sel 
M350 maka akan pindah ke sel M1

Cursor akan pindah ke sel baris terakhir (65536) à misalnya 
dari sel B5 maka akan pindah ke sel B65536

Tombol KETERANGAN
End + Cursor akan pindah ke sel Kolom pertama (A) à misalnya dari sel 

M350 maka akan pindah ke sel kolom A350

End + Cursor akan pindah ke sel Kolom terakhir (IV) à misalnya dari sel 
kolom B50 maka akan pindah ke sel kolom IV50

End + 
Home

Cursor akan pindah ke sel A1 dari manapun cursor berada (posisi 
aktif)

Enter Cursor akan pindah satu sel ke bawah

Home Cursor akan pindah ke sel kolom A x, dari posisi cursor aktif Kolom 

X, Baris x

Ctrl + 
Home

Cursor akan pindah ke sel kolom A1 dari posisi cursor aktif Kolm 
x, baris x

PgUp Cursor akan pindah satu layar ke atas

PgDn Cursor akan pindah satu layar ke bawah

Alt + PgUp Cursor akan pindah satu layar ke kiri

Alt + PgDn Cursor akan pindah satu layar ke kekanan

Ctrl + PgDn Cursor akan pindah dari satu tab lembar kerja ke tab lembar kerja 
berikutnya

Ctrl + PgDn Cursor akan pindah dari satu tab lembar kerja ke tab lembar kerja 
sebelumnya

Bekerja Dengan Lembar Kerja
1.	 Sel merupakan tempat dimana data akan di letakkan, lebar dari suatu 

sel dapat diatur sesuai dengan panjang data yang akan kita simpan
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2.	 Istilah dalam lembar kerja:
a.	 Sel (cell) adalah pertemuan baris dan kolom
b.	 Range adalah jarak antar sel misalnya sel A1 s/d sel X30 (A1:X30)

3.	 Memasukkan Data
a.	 Pindahkan Cursor ke sel dimana data akan di taruh/masukkan
b.	 Ketik data lalu enter

4.	 Mengedit Data
a.	 Pindahkan cursor ke sel tempat data yang akan di edit (diperbaiki) 

kemudian tekan F2.

Menghapus Data
1.	 Menghapus isi sel: pindahkan pointer (cursor) ke sel yang isinya akan 

dihapus, kemudian tekan spasi, kemudian tekan enter atau dari posisi 
sel yang akan dihapus klik kanan pada mouse pilih clear contents

2.	 Menghapus baris: pindahkan pointer (cursor) ke baris yang akan 
dihapus, tekan mouse kanan, pilih delete, pilih Entire row

3.	 Menghapus Kolom: pindahkan pointer (cursor) ke kolom yang akan 
dihapus, tekan mouse kanan, pilih delete, pilih Entire column.

Mengeblok Data
Cara untuk memperbaiki sebagian besar data dapat dilakukan dengan 
mengeblok data yang akan diberbaiki tampilannya misalnya diubah 
menjadi Huruf Tebal atau Huruf Miring dsb. Caranya:

Gunakan mouse: letakkan pointer di awal sel yang akan di blok, 
tekan tombol kanan mouse (jangan dilepas) geser ke posisi sel terakhir 
yang akan diblok

Menyalin Data (Mengkopi)
Menyalin data berati meletakkan data pada tempat yang lain sementara 
data asli masih tetap berada di tempat semula. Ada berbagai cara untuk 
menyalin data, di antaranya adalah sebagai beriklut:
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Menyalin data dengan melalui Clipboard
1.	 Sorot (blok) sel atau range yang datanya akan di copy, contoh sorot 

range B2:E12
2.	 Pilih dan klik menu Edit, Copy atau tekan tombol Ctrl+C. Cara lain 

yaitu dengan menempatkan penunjuk mouse tepat pada posisi sel 
atau range yang disorot (blok), tekan tombol mouse sebelah kanan 
satu kali sampai menu sortcut ditampilkan, lalu pilih dan klik copy

3.	 Letakkan penunnjuk sel (cursor) ke posisi baru dimana data hasil 
copy akan diletakkan, sebagai contoh pindahkan penjuk sel ke G2

4.	 Pilih dan klik menu Edit, Paste atau tekan tombol Ctrl+V, cara lain 
dengan menempatkan penunnjuk mouse tetap pada posisi sel dimana 
hasil copy akan diletakkan ( G2 ) kemudian tekan tombol mouse 
sebelah kanan satu kali sampai menu sorcut ditampilkan, lalu pilih 
dan klik Paste.

Mencetak Lembar Kerja
Untuk mencetak lembar kerja, terlebih dahulu printer yang akan digunakan 
telah terpasang dengan baik (terinstall) secara software dan hardware. Jika 
dalam komputer terinstall/terpasang lebih dari satu printer, maka untuk 
memilih printer ikuti langkah- langkah berikut:
1.	 Pilih dan klik menu File, Print atau tekan tombol Ctrl+P, kotak dialog 

Print terlihat seperti Gambar 5.1
2.	 Pada tombol daftar pilih Name, pilih dan klik printer yang sesuai 

(yang terpasang dalam komputer), kemudian klik Ok
3.	 Klik Ok.

Membuat Penomoran Otomatis
MS-Excel bekerja pada tabel, oleh karena itu untuk menandai baris pada 
sisi kanan biasanya dibuat penomoran baris. Cara membuat penomoran 
secara otomatis dapat dilakukan dengan dua cara. Cara yang pertama, 
menggunakan langkah sebagai berikut:
1.	 Ketikan nilai awal nomor misalnya 1 (satu) pada cell penomoran.
2.	 Pilih menu Edit > Fill > Series.
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3.	 Pada radio button Series in pilih Columns dan text area Stop Value 
dengan nilai akhir penomoran misalnya 10 (sepuluh).

4.	 Klik OK

Ketikan nomer awal di cell penomoran

1.	 Ketikan nomer berikutnya di bawahnya
2.	 Blok keduanya dan letakkan cursor dipojok kanan bawah sehingga 

cursor berubah seperti bentuk ketiga.
3.	 Klik kiri, jangan dilepas (drag) dan tarik ke bawah dan berhenti 

sampai nomor yang dikehendaki dan lepas klik.

Membuat Link
Untuk membuat suatu link pada excel, ikuti langkah – langkah di bawah 
ini:
1.	 sorot cell yang akan di link apabila itu suatu teks, atau sisipkan shape, 

clipart, chart atau yang lain untuk di link.
2.	 Pilih Menu Insert, lalu klik hyperlink.
3.	 Terdapat empat pilihan untuk link, yaitu:

a.	 Existing File or web page: berfungsi untuk melink-kan ke situs 
internet.

b.	 Place in this Document: untuk melink-kan di worksheet excel 
saja Misal di sheet 1, sheet 2atau sheet 3, dll).

c.	 Create new document: untuk melink-kan pada lembar kerja baru. 
E-mail Address: untuk melink-kan pada e-mail.
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4.	 Klik Ok. Apabila link berupa teks, maka teks tersebut akan berubah 
warna menjadi biru danbergaris bawah.

Fungsi Logika
Fungsi logika atau bersyarat memungkinkan kita menguji persyaratan 
dalam sel. Fungsi bersyarat ini adalah suatu kondisi atau =IF yang 
hasilnya bergantung pada benar atau salahnya pengujian. Fungsi Logika 
memerlukan operator perbandingan yaitu:

= (sama dengan)
< (lebih kecil dari)
> (lebih besar dari)
<= (lebih kecil sama dengan)
>= (lebih besar sama dengan)
<> (tidak sama dengan)

Fungsi pada MS-Excel
Fungsi pada MS-Excel digunakan untuk mempermudah pekerjaan pada 
tabel. Dari banyak fungsi dapat diklasifikasikan menurut banyaknya 
operan (parameter) yang masuk dalam fungsi. Bisa juga diklasifikasikan 
berdasarkan disiplin ilmu yang memakainya. Pada pembahasan ini hanya 
akan dibahas sedikit fungsi-fungsi berdasarkan pemakaiannya.
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Bab VIII
Canva

Canva merupakan media yang menyediakan template untuk membuat 
desai simple. Kita dapat membuat semua grafik, blog, presentasi, 
facebook cover, flyer, undangan dan sebagainya.

Cara mengakses Canva
1.	 Buka alamat www.canva.com

2.	 Hal yang pertama dilakukan adalah mendaftarkan akun kita ke canva. 
Pilih salah satu topik yang kita butuhkan. Klik Edukasi yang biasanya 
digunakan oleh pengajar dan siswa

http://www.canva.com/
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3.	 Klik cara masuk yang Anda pilih, bisa dengan akun gmail yang sudah 
anda miliki atau dengan email lain.

4.	 Kemudian verifikasi email yang Anda masukkan, dan canva siap 
digunakan

5.	 Setelah muncul tampilan awal, Anda dapat melihat berbagai design 
dengan mengklik More pada kolom create a design.
Adapun Tools yang dapat Anda gunakan di Canva adalah
a.	 Presentation, untuk membuat desain presentasi
b.	 Resume, untuk membuat daftar riwayat hidup/Curriculum Vitae
c.	 Facebook Post, untuk membuat desain gambar yang akan Anda 

unggah ke facebook
d.	 Infographic, untuk membuat infografis
e.	 Poster, untuk membuat desain poster
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Cara menggunakan tools Presentation
1.	 Klik menu Presentation

2.	 Tampilan awal menu Presentation. Adapun tools yang dapat 
digunakan adalah sebagai berikut:
Keterangan
a.	 File, kembali ke Home tempat Anda menyimpan file
b.	 Undo, kembali ke pengaturan sebelumnya
c.	 Redo, kembali ke pengaturan sesudahnya
d.	 Judul, nama file
e.	 Bagikan, tools untuk membagikan link canva Anda ke berbagai 

media
f.	 Download, tools untuk menyimpan file
g.	 Membuka akses untuk publik, membuka canva Anda agar dapat 

dilihat publik
h.	 Penunjuk Slide Presentasi, menunjukkan susunan slide yang 

sedang dikerjakan
i.	 Duplikat Slide, menggandakan slide yang sama
j.	 Slide, slide yang dapat diedit
k.	 Menambahkan slide baru, untuk menambahkan slide baru sesuai 

dengan susunan slide yang sedang dikerjakan
l.	 Upload gambar/bagan/grafik, mengupload gambar/bagan/grafik 

dari komputer Anda
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m.	 Gradasi Background, memberikan efek gradasi pada backgroun 
slide Anda

n.	 Jenis font, menyediakan berbagai jenis font
o.	 Shape
p.	 Bentuk layout, memilih layout untuk semua slide presentasi Anda
q.	 Pencarian

3.	 Klik Layout, kemudian pilih layout mana yang diinginkan. Untuk 
layout yang bertuliskan free bisa didownload langsung dalam bentuk 
PDF, sedangka n yang tertulis harganya hanya bisa digunakan dan 
dipresentasikan secara online

4.	 Klik Elements untuk membuat bagan
5.	 Klik Text untuk memilik jenis tulisan
6.	 Klik Background untuk memilih jenis background
7.	 Klik upload untuk menambahkan gambar

Cara menambahkan Slide baru
1.	 Klik tanda add a new page, atau
2.	 Klik tanda Lembar dibawah angka penunjuk Slide, untuk menduplikat 

slide

Cara memberikan nama Slide
1.	 Klik Presentation-Untitled Design
2.	 Tuliskan nama yang Anda inginkan

Cara mengunduh presentasi
1.	 Klik Unduh/Download
2.	 Pilih bentuk file presentasi yang diinginkan
3.	 Tentukan halaman mana yang akan didownload
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Bab IX
Instalasi Windows

Mengenal Windows 10
Windows 10 adalah sistem operasi komputer pribadi yang dikembangkan 
dan dirilis oleh Microsoft sebagai bagian dari keluarga Windows NT dari 
sistem operasi. Secara resmi diluncurkan di September 2014 menyusul 
demo singkat di Build 2014. Versi pertama dari sistem operasi memasuki 
proses pengujian beta publik pada bulan Oktober 2014, menjelang rilis 
konsumen pada tanggal 29 Juli 2015.

Rilis pertama dari Windows 10 juga memperkenalkan sistem desktop 
virtual, fitur jendela dan desktop yang manajemen disebut Task View, 
web Microsoft Ujung Browser, dukungan untuk sidik jari dan pengenalan 
wajah login, fitur keamanan baru untuk lingkungan perusahaan, dan 
DirectX 12 dan WDDM 2.0 untuk meningkatkan kemampuan grafis 
sistem operasi untuk game.

Microsoft digambarkan Windows 10 sebagai “sistem operasi sebagai 
layanan” yang akan menerima update terus-menerus untuk fitur dan 
fungsionalitas.
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Kelebihan dan Kekurangan Windows 10
1.	 Sistem windows 10 rupanya memiliki kemampuan menggabungkan 

tombol start menu yang terdapat pada windows sebelumnya yaitu 
window 7 dan 8. 

2.	 Bahkan keunggulan windows 10 juga terletak pada kemampuannya 
menampilkan beberapa aplikasi (multi aplikasi) hanya dalam satu 
layar saja. 

3.	 Selain itu dengan kemampuan yang demikian canggih Windows 10 
dilengkapi dengan fasilitas virtual dekstop. Pengguna bisa memakai 
layar dengan tema yang berbeda dalam satu tampilan layar. 

4.	 Pengguna juga bisa berpindah dari satu dekstop ke dekstop yang lain 
dengan cepat. Tentunya ini menjadi sajian yang demikian berkesan 
dari sistem baru tersebut. 

5.	 Windows 10 hadir untuk semua kebutuhan perangkat seperti 
komputer/PC, gadget, dan lain-lain. 

6.	 Windows 10 jika ingin diupgrade pun tak butuh biaya alias gratis. 
Jadi pengguna yang sebelum memiliki sistem operasi Window 7 atau 
8 bisa melakukan pembaruan ke Windows 10.

Kelemahan Windows 10:
1.	 Fitur dan performa yang dihadirkan Windows 10 belumlah optimal. 

Lihatlah tampilan pada Windows 10 yang tak berbeda jauh dengn 
versi sebelumny yaitu Windows 8. 

2.	 Belum familiar bagi pengguna Windows 8. Bagi pengguna yang belum 
akrab dengan Windows 10 barangkali masih akan dijumpai beberapa 
kesalahan logika atau bug pada kinerja perangkat.

3.	 Jika pengguna tak hati-hati saat mengupgrade sistem operasi Windows 
10 kemungkinan terjadinya default browser bisa dijumpai. Dan default 
browser bakal berubah ke Microsoft Edge secara otomatis. 

Cara Instalasi Windows 10:
Ada beberapa cara, salah satunya menggunakan VirtualBox dan USB 
Flashdisk atau DVD
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Langkah-Langkah Instalasi Windows 10 Menggunakan VirtualBox

1.	 Buka terlebih dahulu VirtualBox yang sudah terinstall. Kemudian 
tekan shortcut Ctrl+N untuk membuat komputer virtual.

2.	 Di sini kita diharuskan untuk menamai komputer virtual yang akan 
kita buat. Dan menyesuaikan tipe juga versi file ISO yang kita miliki. 
Karena kita akan menginstall windows 10, maka pada kolom tipe 
pilihlah Microsoft windows. Klik “Next” untuk melanjutkan.
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3.	 Mengatur RAM yang akan digunakan untuk komputer virtual. Klik 
“Next” untuk melanjutkan.

4.	 Pada tahap ini klik “Create” untuk membuat harddisk virtual pada 
mesin virtual komputer.

5.	 Selanjutnya pilih tipe berkas untuk harddisk virtual baru, umumnya 
yang digunakan adalah VDI. Klik “Next” untuk melanjutkan.
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6.	 Pilih “Dinamicly allocated”. Lalu klik “Next”. 

7.	 Aturlah besarnya lokasi dan ukuran berkas yang akan dipakai. Di sini 
kita gunakan sesuai yang direkomendasikan yakni 25.00 GB. Pilih 
“Create” untuk melanjutkan.
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8.	 Pada tampilan selanjutnya ini, klik menu “Start” dengan ikon tanda 
panah hijau pada bagian atas untuk memulai

9.	 Pilih ikon berkas berwarna coklat untuk menuju lokasi sistem operasi 
kamu diletakkan. Jika sudah, klik “Start” untuk memulai penginstalan.
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10.	 Pada tahap ini, komputer virtual akan melakukan booting seperti 
tampilan di bawah. Tunggu hingga muncul tampilan berikutnya.

11.	 Ketika muncul tampilan berikut di bawah, ini merupakan jendela 
untuk memilih bahasa yang akan digunakan selama penginstallan 
berlangsung. Klik “Next” untuk melanjutkan.
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12.	 Selanjutnya, klik “Install Now”

13.	 Tunggu hingga muncul tampilan selanjutnya.
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14.	 Pada jendela License terms, centang pada kolom “ I accept….” 
Kemudian klik “Next”

15.	 Pilih “Custom: Install Windows only (advanced).

16.	 Pada tahap ini, adalah pembagian partisi sesuai dengan yang 
diinginkan. Klik “Next” jika sudah selesai.
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17.	 Windows setup akan memulai penginstalan windows. Cukup tunggu 
sampai proses selesai. Setelahnya windows akan reboot. 

18.	 Tahap selanjutnya adalah Windows akan mulai merestart.
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19.	  Tunggu beberapa saat.

20.	 Klik “Use Express Setting” untuk melanjutkan.

21.	 Isilah kolom sesuai dengan perintah untuk membuat akun laptop/
PC anda.
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22.	 Tunggu beberapa menit dan proses penginstallan Windowss 10 pun 
telah selesai.

Langkah-Langkah Instalasi Windows 10 Menggunakan Har-
ddisk atau DVD
Silakan backup dulu semua data file dan dokumen yang ada di Local disk C

1.	 Jika harddisk di komputer anda dipartisi silakan rename masing-
masing local disk atau partisi tersebut. Misalnya untuk Local disk 
(C:) ganti namanya menjadi Windows (C:), untuk Local disk (D:) 
ganti menjadi: Data (D:)

2.	 Masukkan Flashdisk Bootable Windows di USB, jika anda ingin 
menjadikan USB Flashdisk sebagai sumber installansi. Atau masukkan 
DVD Windows ke drive DVD-ROM, jika anda ingin menginstal 
Windows dari keping DVD.

3.	 Selanjutnya silakan restart komputer anda.
4.	 Sebelum mulai loading segera tekan tombol F2 pada keyboard untuk 

masuk ke BIOS Setup. Tombol untuk masuk ke BIOS, setiap merk 
komputer bisa saja berbeda, jadi silakan sesuaikan dengan merk 
komputer anda masing-masing.

5.	 Jika tombol yang anda tekan benar maka akan tampil layar BIOS 
seperti di bawah ini
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6.	 Silakan klik menu Boot di atas kemudian atur agar Removable Devices 
menjadi urutan paling atas. untuk merubah urutannya dengan 
menggunakan tombol +/- pada keyboard, atau sesuaikan dengan 
petunjuk yang ada pada taskbar BIOS pada bagian Change Values

7.	 Setelah Removable devices berada di urutan teratas, pilih menu Exit 
dan silakan Save.

8.	 Komputer atau laptop anda akan kembali restart, tunggu saja sampai 
muncul jendela seperti di bawah ini. Pada sesi ini mouse anda sudah 
berfungsi.
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9.	 Pada bagian Time and Curency Format, silakan pilih Indonesia
10.	 Pada bagian Keyboard or input method, biarkan apa adanya tidak 

usah diganti
11.	 Klik Next yang ada di bawah sebelah kanan 
12.	 Kemudian Klik “Install now” untuk melanjutkan
13.	 Muncul halaman lisensi, beri tanda centang pada I acccept the license 

terms atau klik skip
14.	 Akan muncul jendela pilihan tipe install, Upgrade atau Custom.

15.	 Atur Partisi untuk memilih penginstalan sistem sesuai dengan 
keinginan.
a.	 Jika memilih Upgrade, maka Windows lama akan diganti dengan 

Windows baru dengan tanpa menghapus semua program aplikasi, 
file dokumen, data dan juga virus jika ada.

b.	 Jika memilih Custom, dengan memformat drive C, maka semua 
program aplikasi, file dokumen, data dan semua yang tersimpan 
di Local disk (C:) termasuk virus akan musnah. Dan Windows 
jadi benar-benar baru belum ada tambahan aplikasi apapun.

c.	 Jika memilih Custom tanpa melakukan format drive C, maka 
folder Document, Ficture, Video, Music dan folder Download 
akan tersimpan sementara dalam folder Windows Old. Jadi 
nantinya di drive C, akan ada dua folder Windows, yaitu Windows 
Old yang tidak aktif dan Windows yang baru diinstall (aktif)
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16.	 Drive yang akan kita install yaitu drive C yang telah diberi nama 
Windows 10, jadi silakan klik pada Drive 0 Partition 2: Windows 10, 
kemudian klik Format

17.	 Jika keluar jendela notifikasi Windows setup, klik saja Yes
18.	 Tunggu beberapa saat, jika tombol Next yang ada di bawah kanan 

sudah aktif berarti proses format drive C telah selesai. Klik saja tombol 
Next tersebut

19.	 Memulai proses transfer dan instalasi secara otomatis.

20.	 Setelah semua intalasi selesai maka komputer anda akan melakukan 
restart otomatis. Perhatikan baik-baik, begitu komputer anda restart, 
segera cabut flashdisk bootable dari USB komputer anda, dan biarkan 
Windows instalasi Windows berjalan sendiri.
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21.	 Setelah restart otomatis beberapa kali, nanti diminta memasukan data 
nama dan pengaturan, bisa diisi bebas.

22.	 Setelah muncul halaman Windows 10 seperti di bawah ini, berarti 
proses instalasi telah selesai
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